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I. PURPOSE 

This document establishes basic format and style conventions for letters the Office of 
New Animal Drug Evaluation (we) issues to sponsors and other outside parties. 

II. STANDING AND IMPACT OF OUR LETTERS 

Our letters are part of official government records and, as such, need to ensure 
adequate and proper documentation of our decisions and transactions. 

Our letters also can have significant impacts on their recipients.  Based on their 
understanding of our letters, sponsors may make decisions to reallocate the sponsor’s 
priorities, time, money, and effort to serve the needs of the company.  Therefore, we 
should issue letters that clearly and precisely convey our decisions on particular issues. 

III. FORMAT AND STYLE CONVENTIONS 

A written letter is our principal and preferred form for communicating information to 
sponsors or other outside parties.  These letters document our decisions as they relate to 
particular issues.  Adhering to a set of format and style conventions increases the 
consistency in the quality and appearance of our letters. 
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Experts have published style manuals presenting their particular preferred format and 
style conventions for writing letters.  These preferred styles and conventions are not 
entirely consistent, nor do they remain static over time.  The preferred set of 
conventions and styles we have adopted in this document consider several experts’ sets 
of styles and conventions, our past practices, and our need for clarity and consistency 
in the letters we issue. 

If we have developed a template for a particular type of letter, you should use it.1  If we 
have not developed one, you should draft your letter consistent with the styles and 
conventions presented in this document. 

A. Paper copies of letters 

1. Issuing letter 

The issuing letter is the signed copy of the letter that we send to the addressee, 
i.e., the sponsor or other outside party. 

As the preparer of the letter, you should print the first page of a letter on 
department (Department of Health and Human Services) letterhead paper, i.e., 
watermarked bond paper displaying the department’s official pre-printed blue 
letterhead logo.2  You should print the remaining pages of a letter on quality 
watermarked bond paper. 

2. File copy 

The file copy of the letter, which includes any enclosures, is the paper copy 
that we print on plain (i.e., without department letterhead) pink paper and 
place in the administrative file.3  The use of pink paper helps us find this letter 

 
1 The Office’s goal is to develop templates that adhere to these format and style conventions as well as 
provide some flexibility to address division needs.  If you find that the template is not consistent with these 
conventions or will not adequately convey the information necessary, you should discuss the need for revising 
the current template with your division director (or staff leader).  If a revision is necessary, you and your 
division director should discuss the proposed revision with the ONADE Policy Team.  They will evaluate 
whether the proposed revision is necessary or another alternative action is preferable. 
2 Do not use computer-created facsimiles of the letterhead logo for the letter. 
3 Examples of administrative files for STARS submissions include generic investigational new animal drug 
files (JINADs), new animal drug application (NADAs), or veterinary master file (VMFs). 
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in the administrative file.  We keep these paper administrative files in our 
records archive (the Document Control Unit). 

B. Margins 

You should use the following margins on all letters: left margin of 1.25 inches; 
right, top, and bottom margins of 1 inch. 

C. Fonts 

You should use Times New Roman (12 point) as the principal font family.  The 
predominant font style you should use is “regular.”  You may use italic and bold 
styles judiciously for emphasis and clarity.  You may also use other font effects 
such as underline, CAPITALIZATION, and SMALL CAPITALIZATION sparingly.  
The overuse of font styles and effects can compromise clarity.  You should not 
manually adjust the spacing between characters (i.e., kern fonts). 

If writing the proprietary name, do not use trademark symbols (® or ™).  To 
identify the proprietary name, refer to the proprietary name box on the most 
recently submitted Form 356V, if applicable.  Write the portion of proprietary 
name to the left of the trademark symbol in ALL CAPS in our documents.  If the 
proprietary name contains words to the right of the trademark symbol, capitalize 
the first letter of each word (e.g., Program® Injectable Solution would be 
PROGRAM Injectable Solution).  For proprietary names that are not trademarked, 
capitalize the first letter of each word. 

When you need to use Greek, and similar, characters, you should insert them using 
the Symbol font (12 point).  You should use Microsoft Equation or the MathType 
plug-in for Microsoft Word for statistical equations and similar uses. 

You should embed all fonts used in the letter in the electronic file of the letter.  See 
P&P 1243.3005 

D. Headers 

Letters exceeding one page in length should have a right-justified 12-point header 
beginning 0.5 inches from the top paper edge.  This header should be visible on the 
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second and subsequent pages.4  Typically, the header consists of the principal 
submission identification, e.g., I-012345-P-0123-EF, on the first line and a “Page 
x” entry on the second line. 

Example: 

I-012345-P-0123-EF
Page 2

 
If the letter addresses two principal submissions from one document or one 
submission from each of two documents, use two lines to identify the principal 
submissions. 

Example: 

I-012345-G-0100-OT
I-013001-G-0004-OT

Page 2
 

If the letter addresses three or more principal submissions, the first line should 
identify only the first submission listed in the principal submission identifier field 
followed by the phrase “et al.” to indicate the additional submissions. 

Example: 

N-012635-C-0100-OT, et al.
Page 2

 
Where the letter does not address a submission, the first line of the header should 
be the content of the reference (“Re:”) line. 

Example: 

Reference line text here
Page 2

                                                 
4 To format the header, click on “Page Setup” from the “File” menu of Microsoft Word, select the “Layout” 
tab, check the “Different first page” box, and set the “Header” to 0.5 inches from the edge. 
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E. Principal submission identification field 

This field identifies the principal submission(s) to which this letter responds.  
Amending submissions, or other submissions that provide ancillary or supporting 
information, are not considered principal submissions and thus are not identified 
here.5  The identification of a principal submission consists of the one uppercase 
letter designation of the document type, the 6-digit document number, the one 
uppercase letter designation of the submission type, the 4-digit submission 
number, and the two uppercase letter subclass code, separated by dashes. 

This field is the top-most text placed on the first page.  It begins at the left margin 
on a line that is no less than 0.75 inches below the top margin of 1 inch.  When a 
one-page letter is brief, you can begin the letter by placing this field further down 
the page to “center” the letter on the page visually. 

If the letter addresses an issue that applies to a group of principal submissions, 
include identification of all principal submissions in this field.  The display order 
of multiple principal submissions is determined by sequentially alphabetizing by 
document type, placing in numerical order by document number within document 
type, and, if necessary, placing in numerical order by submission number within a 
document.  For a letter that addresses two principal submissions, list the 
submissions on consecutive lines using the display order.  If the letter addresses 
three or more principal submissions, create a multi-row three-column (of equal 
width spanning the text area (6.25”)) table that is sufficiently large to capture all 
principal submissions.  You should fill the table cells using the display order in a 
“top to bottom” order within a column and “left to right” by columns.  You should 
set the format of the table borders to “None”.6  You should left-justify the table 
cell contents. 

 
5 See section III.L.1 for how these amending and other ancillary submissions are identified in the cc: block. 
6 To set the table borders to “None” in Microsoft Word, select the table (by dragging to highlight the table, 
clicking in the table and then on the “table square” near the top left of the table, or clicking in the table and 
then clicking (in succession) “Table” on the “Tools” menu, “Select” from the drop-down menu, and then 
“Table” in the secondary menu).  Once the table is selected, click “Format” on the “Tools” menu, click 
“Borders and shading” from the drop-down menu, click the “Borders” tab, click the “None” setting, and 
accept the command by clicking the “OK” button or pressing the “Return” key. 
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Examples: 

I-012345-G-0011-OT 
N-141141-G-0234-OT 

 
 

N-100635-C-0100-OT N-113645-C-0101-OT N-141068-C-0052-OT 
N-101314-C-0098-OT N-123045-C-0100-OT N-141071-C-0027-OT 
N-101315-C-0097-OT N-141013-C-0088-OT  

 
F. Inside address 

Direct the letter to the attention of whoever signed the cover letter of the 
submission.  Use the address of the cover letter accompanying the application.7 

In situations where the sponsor is not the company identified in the letterhead, 
identify the sponsor by name in the opening paragraph of the letter.8  If the address 
or contact information has changed since the application was received, document 
this change in a memorandum to the file or your review and use the new 
information for the letter. 

You should follow the addressee’s preference in the spelling, capitalization, 
punctuation and spacing of his or her name and title as evident from the letter 
received.  Likewise, follow the indicated preference for the company’s name and 
address.  The inside address begins two blank lines below the principal submission 
identification field. 

Example: 

Drug Company International 
Attention:  John Doe, DVM, PhD 
Manager, Regulatory Affairs 

                                                 
7 With the exception of master files, address all communications with a foreign sponsor to their U.S. agent. 
8 Examples of when a letter or submission may not be sent to us directly by the sponsor and may be sent by 
another party on the sponsor’s behalf:  1) the company is not a United States company, they will have U.S. 
Agent; 2) correspondence may come from consultants; 3) a parent company submits information on a 
subsidiary’s behalf. 
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1100 Industrial Drive, Suite 500 
Anytown, NJ  55555 

 
G. Reference line 

The reference line should briefly (typically 3-8 words) identify the main topic of 
the letter.  The reference line begins one blank line below the inside address. 

Example: 

Re:  Request for review of study protocol 2005-123abc-ver3b 
 
H. Salutation 

You should look to the signature block of the submission to help identify the most 
appropriate title of the individual to whom the letter is addressed.  The salutation 
of our letter should respect titles conferred by professional degree.  You should 
abbreviate most titles (e.g., Mr., Mrs., Ms., and Dr.) and use only the surname.  
The salutation should begin one blank line below the reference line. 

Example: 

Dear Dr. Doe: 
 

I. Body of letter 

You should not indent the first line of a paragraph.  Each paragraph should begin 
at the far left margin or, for subordinate paragraphs, at the new margin established 
by the subordinate position of the paragraph.  You should separate paragraphs by 
one blank line. 

1. First paragraph 

The first sentence should convey our main decision regarding the issue 
presented in the letter(s) to which we are responding.  You should use the 
remaining sentences of this paragraph to provide the supporting and limiting 
information that place the main decision or action in the proper and accurate 
context. 
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2. Subsequent paragraphs 

These paragraphs (if needed) should convey all other necessary information to 
provide a complete response for the letter to which we are responding.9  What 
constitutes a complete response may vary with the type and quality of the 
letter or submission. 

3. Closing paragraph 

The final paragraph politely ends the letter.  You should include a sentence 
instructing the recipient to refer to the date and the principal submission 
identification field found at the top of our letter when submitting 
correspondence relating to our letter.  You should also identify an individual 
the addressee can contact for further information.  If the contact is the 
individual who signs the letter, you should include his or her telephone 
number.  If the contact is someone other that the individual who signs the 
letter, you should identify that individual by name, organizational title, and 
telephone number. 

J. Complimentary closing and signature block 

You should use “Sincerely,” as the complimentary closing.  The closing begins 
one blank line below the closing paragraph. 

The content of the signature block should conform to that established for the 
individual signing the letter.  The first line of the signature block should begin 
three blank lines below the closing. 

You should indent the closing and signature block 3 inches from the left margin. 

 
9 A complete response means that we have addressed the issues raised in the letter consistent with our 
regulations and policies. 
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Example: 

Sincerely, 
 
 
 
Steven D. Vaughn, DVM 
Director 
Office of New Animal Drug Evaluation 

 
K. Enclosure notation 

You should insert this notation only if additional items are included in the 
envelope with the letter.  The enclosure information begins at the left margin two 
blank lines below the bottom of the signature block.  The first line is “Enclosure:” 
(plural if more than one enclosure).  The second and additional lines are brief 
descriptions of the enclosures (one line per enclosure). 

All enclosures itemized in the letter should be included behind the letter in the 
order mentioned.  You should print (or photocopy as necessary) the enclosures on 
good quality plain (no watermark) white paper.  You should individually staple the 
enclosures, if necessary. 

Example: 

Enclosures: 
Title (or brief description) of enclosure 1 
Title (or brief description) of enclosure 2 

 
L. Internal administrative tools 

We use several administrative tools (cc: blocks, concurrence tables, and the other 
administrative information box) to document the internal processing and clearance 
of our letters.  All of this administrative information should always appear on our 
file (pink) copy of the letter.  Issuing letters should never include internal routing 
and clearance information and only in rare situations (see below) contain a cc: 
block. 
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1. cc: block notation 

The cc: block begins two blank lines below the last line of the signature block, 
or enclosure notation (if present). 

You should not include a cc: block in an issuing letter except to indicate that 
we are sending the letter to other parties external to FDA.  Internal (FDA) 
routings of the letter are never included in the cc: block of the issuing letter. 

In contrast to the identification of only principal submissions in the header and 
the principal submission identification field, the cc: block on the file (pink) 
copy should list all submissions being completed with the final action 
package.  The submissions of each document should be on a single line. 

As a matter of routine, we should not create paper copies of the issuing letter 
for CVM personnel nor include them in the cc: list.  Interested CVM 
individuals can find copies of these letters in our electronic archive.  In those 
instances where paper copies of the letter are necessary for use outside of 
CVM (but within FDA), you should note these copies in the cc: block of the 
file (pink) copy. 

Examples of cc: block notation for a file (pink) copy: 

cc: Document Control Unit, for the administrative file of: 
  I-012345-P-0123-EF, T-0125, T-0126 

 
cc: Document Control Unit, for the administrative files of: 
  I-012345-P-0123-EF, T-0125, T-0126 
  I-012875-G-0088-OT, T-0090 
  I-012903-G-0045-OT, T-0046 
  I-013004-G-0007-OT, T-0008 

 
cc: Document Control Unit, for the administrative file of: 
  I-012345-D-0123-OT, T-0125, T-0126 
 USDA/FSIS 

 
Note that the issuing letter of the last example would include a cc: notation: 
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cc: USDA/FSIS 
 

2. Concurrence table 

The purpose of the concurrence table is to provide a standardized method and 
place to indicate review of, and concurrence with, the letter.  The table should 
indicate all participants (except the signer of the letter) in the review and 
clearance process for the letter beginning with the primary reviewer.  The 
exact participants identified in the table will vary with the type of letter and 
the review group responsible for its review.  The signer of the letter indicates 
concurrence by signing the letter.  The table should identify each individual 
by role and organizational unit.  For most issuing letters, you only need to 
indicate concurrence with the final letter.  However, for a few letters, most 
notably approval letters, you should indicate concurrence on the draft and 
final letter. 

Example: 

Concurrence Signature & Date 

individual name, Primary Reviewer, 
team name 

 

individual name, Leader, team name  

[if appropriate, insert information 
regarding specialty team/division 
personnel: individual name, title, and 
team name] 

 

template version- date
 

3. Other Administrative Information 

This area is used to record additional information such as a preparer line, 
notation of electronic copies, to document draft tracking, and to record 
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supervisory review, when applicable10.  The default for this field is “not 
applicable.”  Do not delete the box or heading. 

M. Envelope 

The envelope accompanying the letter should: 

• Be appropriately sized for the material being sent, 

• Be pre-printed with the department’s return address, 

• Be addressed to match the inside address of the letter, and 

• Have the Document Control Unit (DCU) mail code (HFV-199), added 
by hand or printer, above the return address of the envelope to allow 
proper return of the letter if the postal service is unable to deliver it. 

IV. WRITING WITH CLARITY 

As discussed in section II, there are important reasons for you to prepare letters of 
exceptional quality and clarity. 

When you draft a letter, you should use plain language writing techniques.11  For 
example, use the active voice when possible and write at the level appropriate for your 
audience.  Writing at a level appropriate to your audience includes remembering that 
they may not be as intimately versed in your area of expertise as you are, so you should 
keep the use of technical acronyms and jargon to a minimum to clearly convey your 
intended meaning.  You may also find the use of the Graham methods of pre-drafting, 
drafting and editing of the letter helpful.12  In addition, use the spell check and 
grammar function of your word processor.  You should proofread the letter to catch 
any errors that automated spell checking and grammar tests may not identify. 

 
10 For information regarding supervisory review of CVM work products and dispute resolution, consult P&P 
1240.2110 “Procedures for Resolving Scientific/Data Disagreements Within CVM.”  
11 See http://www.plainlanguage.gov and http://www.archives.gov/federal_register/plain_language/tools.html. 
12 See Graham, D.O. and J.H. Graham, 2002, The Writing System: A Step-by-Step Guide for Business and 
Technical Writers, Preview Press, Fairfax, VA.  If you have questions or need help with the procedures 
contact the writer/editor from the Quality Assurance Team. 

http://www.plainlanguage.gov/
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V. “CLEAN” ELECTRONIC FILES 

You should critically examine the electronic file of the letter to remove all traces of 
information that are not part of the body of the file.  All electronic files should be 
“clean” and identical to the printed version.13 

VI. REFERENCES 

Books 

Graham, D.O. and J.H. Graham.  2002.  The Writing System: A step-by-step guide 
for business and technical writers, Preview Press, Fairfax, VA. 

Plain language web sites 

http://www.plainlanguage.gov 

http://www.archives.gov/federal_register/plain_language/tools.html 

CVM Program Policy and Procedures Manual 

1240.2110 – Procedures for resolving scientific data disagreements within CVM 

1243.3005 - Creating clean electronic files 

VII.  VERSION HISTORY 

May 24, 2005 – original version 

July 1, 2005 – minor changes to content of concurrence table (section III.L.3) 

September 4, 2007 – Changed to add subclass code to the submission identifier and 
replace the preparer line with the Other Administrative Information box.  Also 
referencing the new P&P 1243.3005. 

                                                 
13 See P&P 1243.3005 on how to create clean electronic files 

http://www.plainlanguage.gov/
http://www.archives.gov/federal_register/plain_language/tools.html


1243.3010

 
 

Responsible Office: Office Of New Animal Drug Evaluation 
Date: December 4, 2008 14
 
 

December 4, 2008 – Revised to clarify that the file copy of all letters and the file copies 
of enclosures accompanying the letter are printed on pink paper.  Removed reference to 
1243.3060 Final document routing and copy distribution, which no longer exists. 
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